
Image Editor
See Also
The Image editor is C++Builder's visual editor. You use it to create and edit images you want to use in 
your application. 

To open the Image editor,
Choose Tools|Image Editor option.

The Image editor displays a new window, where you can create, open, and save various types of image 
files (icon, cursor, and bitmap). The window has its own menu bar, a Colors palette, a Tools palette, and 
palettes for customizing tools.
To see a list of tasks, see Using the Image Editor.
Click any part of the graphic below for additional information.



See Also
Image Editor Menus



Image Editor Menus
For information about C++Builder's Image editor menu commands, choose a menu topic.
File Menu
Edit Menu
Icon Menu
Resource Menu
Text Menu
View Menu
Window Menu
Help Menu
(Help for menu commands is also available by highlighting the menu command and pressing Ctrl+F1. 
Help for dialog boxes is also available by pressing F1 from within the dialog box.)



Colors Palette (Image Editor)
See Also
Images drawn with the Image editor are created on a grid of pixels. You create the image by setting 
each pixel to a foreground or background color. Strictly speaking, there's no difference between the 
foreground and background color. There is, however, a difference in how you choose foreground and 
background colors and in how they are created when you edit the image.
The Image editor's 16-color Colors palette makes it easy to choose foreground and background colors. 
You can work with a Colors palette even if your image is black and white. 
You use the Colors palette to choose a:

Foreground color
Background color



See Also
Choosing the Number of Colors for an Image
Image Editor



Foreground Color
The foreground color is the color you select and draw with the left mouse button. It's typically one of the 
colors you use to create the features of your image, such as lines, boxes, shading, and so on. The 
foreground color is indicated by left most color sample next    to the    Colors Palette.(If you select the 
same color for both foreground and background, you see color in both color sample boxes.)

To use a foreground color,
1. Click the left mouse button on a color in Colors palette to select and display it in the left most color 

sample box next    to the Colors palette.
2. Choose a tool that draws or paints. Click or drag with the left mouse button to draw or paint with the 

foreground color.
The Eraser tool operates in the opposite fashion from the drawing tools. Dragging it with the left mouse 
button produces the background color, and dragging it with the right mouse button produces the 
foreground color.



Background Color
The background color is the color you select and draw with the right mouse button and is usually the 
color that appears to underlie your drawing. It's also the color that's left behind when you select an area 
and delete or move it. The background color is indicated by right most color sample next    to the    Colors
Palette. (If you select the same color for both foreground and background, you see FB on the Colors 
palette.)

To use a background color,
1. Click the right mouse button on a color in the Colors Palette to select and display it in the right most 

color sample box next to the Colors Palette.
2. Choose a tool that draws or paints. Click or drag with the right mouse button to draw or paint with the 

background color.
The Eraser tool operates in the opposite fashion from the drawing tools. Dragging it with the left mouse 
button produces the background color, and dragging it with the right mouse button produces the 
foreground color.



Line Width Palette (Image Editor)
See Also
You use the Line Width Palette to choose the line width for tools that draw lines. The table below lists 
the tools and how they are used.

Tool Selects
Brush Brush width
Line Line width
Ellipse Width of perimeter line
Rectangle Width of perimeter line
Rounded Rectangle Width of perimeter line
To choose the line width, click the one you want.
To change the widths, double-click the width you want to change. The Change Width dialog box is 
displayed, where you enter a new width value.



See Also
Image Editor
Tools Palette



Change Width Dialog Box
The Change Width dialog box customizes the width of the lines in the Line Width Palette.

Width Edit Box
Enter a new value for the line width. The value must be from 0 to 32, where 0 is a null line, and 32 is the 
widest. You might want to experiment with different values; the line width used for the Brush tool 
appears wider than the lines for the other tools.



Style Palette (Image Editor)
See Also
You use the Pattern Style palette to choose the pattern style for tools that use patterns. These tools are:
Brush
Filled Ellipse
Filled Rectangle
Filled Rounded Rectangle
The current style is highlighted by frame. To choose a new style, just click the one you want. 



See Also
Image Editor
Tools Palette



Window Panes (Image Editor)
See Also
The Image editor lets you look at two different views of the image you're creating or editing. The window 
is split vertically to show the two views side-by-side. 
To display a single image, just move the line that divides the windows off the screen. To change the size 
of the windows, move the line. One or both views can be zoomed.



See Also
Image Editor
Zooming Images



Using the Image Editor
See Also
You use the Image editor to create images for your application. 

To access the Image editor click the Image Editor icon. 
To create a new image, choose File|New.
To open an existing image, choose File|Open.
To save an image, choose File|Save or File|Save As.

For more information about using the Image editor, choose one of the following topics:
Working with Bitmaps

Adding Text to an Image
Choosing the Number of Colors for an Image
Displaying Your Image on a Form
Using the Colors Palette

Working with Icons
Working with Cursors
Zooming Images

Moving a Zoomed Image
Using the Zoom Accelerators



See Also
Image Editor
Image Editor Menus



Working with Bitmaps
See Also
Bitmap resources enable you to display graphic images in your Windows program. 
Working with bitmaps involves four basic tasks:
1. Starting the Image editor.
2. Creating or editing a bitmap image file
3. Saving the bitmap image file.



See Also
Using the Image Editor
Editing an Existing Bitmap
Changing the Properties of a Bitmap
Deleting a Bitmap



Adding Text to an Image
See Also
You can add text to any image that was created with the Image editor. To add text to an image, click the 
Text tool. The Image editor displays a flashing cursor. Click the location in your image where you want 
text to start. Then type the text you want.
To determine how text is displayed, use the commands on the Text menu either before or immediately 
after you type the text. You can change the text color by selecting a new color from the Colors palette. 
You can also press the right mouse button if you want the text to be displayed in the current background 
color.
If you click another tool or click in another area of the image after entering text, you can't change 
anything in the text you've just entered. At that point, the text becomes just another part of the image.

Choosing Fonts, Size, and Text Style
To choose how text is displayed, use Text|Font to display the Font dialog box, where you choose the 
typeface, size, and style of the text.

Aligning Text
To align text, you use Text|Left Align, Text|Center Align, and Text|Right Align. Each of these commands 
controls where the text is displayed in relation to where you initially clicked before you typed the text.    



See Also
Using the Image Editor



Choosing the Number of Colors for a Bitmap
See Also
When you first create an image, you choose how many colors you want in your image. 
You can include up to 256 colors in an image. The number of colors you can use (and see in the Colors 
palette) depends on the type of display driver you're using with Windows. The standard Windows VGA 
driver supports a fixed set of only 16 colors.
While you're editing an image, you can change the number of colors in the image. For bitmap images 
with Bitmap|Image Properties.



See Also
Using the Image Editor



Adding a Bitmap to a Form
See Also
Once you've saved your bitmap to a file, you can add it to your form. Here's how:
1. Add an Image (bitmap) component (on the Additional page of the Component palette) to your form.
2. Double-click the image component to open the Picture Editor. From the Picture editor, press the Load 

option to select a desired directory and bitmap.
3. Enter the name of the bitmap image file in the File Name edit box.
4. Click OK to add the picture to the form.
To automatically resize your image when you display it on the form, turn on the Stretch check box in the 
Bitmap properties dialog box.



See Also
Using the Image Editor



Editing an Existing Bitmap
See Also

To edit an existing bitmap,
1. Open an existing project.
2. Double-click the BITMAP resource you want to edit, or select it and choose Edit.
After you open the bitmap in the Image editor, you can customize it. Before you begin working on your 
bitmap, you should zoom it. 
You can choose the bitmap's foreground and background colors, and change its properties. You can 
also delete bitmap resources.
You cannot, however, add transparent and inverted areas to your bitmap. 



See Also
Using the Image Editor
Deleting a Bitmap



Changing the Properties of a Bitmap
See Also
You can change a bitmap's attributes with the Bitmap|Image Properties command.
This command displays the Bitmap Attributes dialog box, where you can:

Define the size of the bitmap image file.
Set a charastic that allows you to stretch the image’s overall size.
Set the image’s color display characteristics. 



Deleting a Bitmap Resource
See Also
To delete a bitmap resource, select it in the resource window and then

Press the Del key or choose Resource|Delete to completely delete it.
Choose Resource|Cut to cut the resource into the Windows clipboard to paste it elsewhere.



Using the Colors Palette
See Also
Bitmapped images drawn with the Image editor are created on a grid of pixels. You create the image by 
setting each pixel to a foreground or background color. Strictly speaking, there's no difference between 
the foreground and background color. There is, however, a difference in how you choose foreground and
background colors and in how they are created when you edit the bitmapped image.
The Image editor's 16-color Colors palette makes it easy to choose foreground and background colors. 
You can work with a Colors palette even if your image is black and white. 
You use the Colors palette to choose:

A foreground color
A background color
Transparent and inverted areas (for icons and cursors only)

You can move the palette anywhere you want it. You can also hide it and show it with the menu 
commands or the palette's control menu. If you're creating a bitmap or icon, you can choose the number
of colors you want to include in your resource. 



Selecting a Foreground Color
See Also
The foreground color is the color you select and draw with the left mouse button. It's typically one of the 
colors you use to create the features of your resource, such as lines, boxes, shading, and so on. The 
foreground color displays in the left most sample box next to the Colors palette. (If you select the same 
color for both foreground and background, you will see both color boxes containing the same color.)

To use a foreground color,
1. Click the left mouse button on the color you want in the Colors palette. The color will display in the left

most color sample box next to the Colors palette. 
2. Choose a tool that draws or paints. Click or drag with the left mouse button to draw or paint with the 

foreground color.
Note: You can also use the Eraser tool by dragging it with the left mouse button to produce a 
background color. Dragging the Eraser tool with the right mouse button will produce a foreground color.



Selecting a Background Color
See Also
The background color is the color you select and draw with the right mouse button and is usually the 
color that appears to underlie your drawing. It's also the color that's left behind when you select an area 
and delete or move it. The background color is indicated by BG on the Colors palette. (If you select the 
same color for both foreground and background, you see FB on the Colors palette.)

To use a background color,
1. Click the right mouse button on a color in the Colors palette. You will see that color display in the right 

most color sample box.
2. Choose a tool that draws or paints. Click or drag with the right mouse button to draw or paint with the 

background color.
Note: You can also use the Eraser tool by dragging it with the left mouse button to produce a 
background color. Dragging the Eraser tool with the right mouse button will produce a foreground color.



Transparent and Inverted Areas
See Also
Transparent and inverted color areas are unique to icon and cursor resources.

A transparent area allows the desktop color behind the icon or cursor to show through. 
An inverted area reverses the desktop color at run time.

The designated transparent and inverted colors do not appear in your icon or cursor at run time. Instead,
they are replaced by the desktop color or its inverse. The colors that you set as Transparent and 
Inverted should be colors that you won't use in your icon or cursor.
The default transparent color is the current desktop color set in the Windows Control Panel's color 
palette. If the desktop uses a dithered color, the default transparent color is the nearest solid color that 
the Image editor can provide. (If you have a 256-color device, this restriction does not apply; the default 
transparent color will always match the desktop color.)
You can change the transparent color to something other than the desktop color, but it will always revert 
to the desktop color each time you start the Image editor. Nevertheless, regions that you designate as 
transparent - using the default color or a color you assign - remain transparent and take on the current 
transparent color.
Note: You can change colors so that you have transparent and nontransparent regions that use the 

same color.



Working with Icons
Icons are small bitmapped images, 16 x 16 or 32 x 32 pixels in size. Windows programs typically use 
customized icons to represent minimized windows. 
Working with icons involves four basic steps:
1. Starting the Image editor.
2. Creating or editing an icon.
3. Testing an icon.
4. Saving an icon.
See Working with Bitmaps for details about each of these steps.



Working with Cursors
See Also
Cursors are bitmapped images 32 x 32 pixels in size that represent the mouse pointer's current location 
on the screen. A Windows application often has a number of different cursors that represent different 
program functions. 
Windows provides a set of standard cursors you can use in your programs. In addition, you can create 
your own customized cursors to represent different functions of the program.
Working with cursors involves four basic steps:
1. Starting the Image editor.
2. Creating or editing a cursor.
3. Testing a cursor.
4. Saving a cursor.



See Also
Using the Image Editor
Creating a New Cursor 
Editing an Existing Cursor
Testing a Cursor



Creating a New Cursor
See Also
You can add a new cursor to a project file, or create the cursor in a standalone file. 

To add a new cursor to an .RC (or .RES) file,
1. Open a project or create a new one.
Choose Resource|New. The Image editor displays a pull-right menu of
valid resources you can select.
3. Select CURSOR to display the list of available Image editor menu options for cursors.
Use the cursor options to set hot spots and test. 



See Also
Using the Image Editor
Working with Cursors



Editing an Existing Cursor
See Also

To edit an existing cursor,
1. Open an existing project.
2. Double-click the CURSOR resource you want to edit or select it and choose Edit.
After you have the cursor open in the Image editor, you can customize it. Before you begin working on 
your cursor, you should zoom it. You can change the cursor's transparent and inverted areas. You can 
also delete cursors.

Design Issues
Before you start, you should have an idea of what your cursor is intended to represent. A typical use of a
custom cursor is to represent the task the user is performing. 
The hot spot is the cursor's active area where the user clicks to activate the task represented by the 
cursor. You need to make the hot spot obvious.
Do not make the cursor complicated. It should be simple enough to fit into a 32 x 32 pixel area. Think 
about where the user is most likely to display your cursor. Background colors and patterns can affect the
cursor's transparent and inverted areas.



See Also
Deleting a Cursor 
Setting the Hot Spot for a Cursor
Using the Image Editor
Working with Cursors
Zooming Images



Setting the Hot Spot for a Cursor
See Also
An important consideration when you customize a cursor is where to put the hot spot (the cursor's active
area). The hot spot is the single pixel in the cursor that fixes the location when the user places the 
cursor and clicks to make a selection.

To set hot spots:
1. Use the View|Zoom In command to zoom in on the cursor image until it's big enough to let you 

precisely choose the pixel coordinates for the hot spot.
2. Display a grid on the zoomed image.
3. Select the Line tool.
4. Point to the location on the zoomed image where you want the hot spot and look at the coordinates 

displayed on the right side of the status line. Make a note of these coordinates.
5. Choose Cursor |Set Hot Spot. 
6. Enter the hot spot's pixel coordinates and click OK.



See Also
Working with Cursors
Editing an Existing Cursor



Deleting a Cursor
See Also

To delete a cursor resource,
Select it in the Resource window then do one of the following:
Press the Del key or choose the Delete button to completely delete it.
Choose the resource, and select Resource|Delete to delete the resource.



Testing a Cursor
See Also
Anytime you want, you can test your cursor by choosing Cursor|Test.
The Image editor turns the current cursor into a test version of your cursor. You can move it around to 
see how it looks on different color backgrounds. When you finish testing, click the mouse to continue 
customizing your cursor.



Zooming Images
See Also
The Image editor can show you an image at its actual size or it can zoom images up to 1600%. You can 
use the Zoom tool or the View menu to zoom the image in one or both of the two window panes. The 
Image editor always zooms the current image.
If you zoom an image to a size that's too large to fit in the pane, and the image is displayed at its true 
size in the other window pane, the Image editor places a dotted rectangle over the unzoomed image. 
This dotted rectangle indicates the portion of the image currently displayed in the zoomed window pane.



See Also
Moving a Zoomed Image
Using the Image Editor
Using the Zoom Accelerators
Zooming a Portion of the Image
Zooming the Entire Image



Zooming an Entire Image
See Also
To zoom in on an entire image, double-click the Zoom tool. 
The Image editor increases magnification of the image to the next level: 400%, 800%, or 1600%. You 
can also choose View|Zoom In to perform the same function on the currently selected window. The 
Image editor uses the center of the image as a reference when zooming the entire image.
To zoom out the entire image, hold down the Shift key and double-click the Zoom tool. The Image editor 
decreases magnification to the next level: 800%, 400%, or 100%. You can also choose View|Zoom Out 
to perform the same function on the currently selected window.
When you work with two window panes, zooming affects only the active window.



See Also
Zooming a Portion of the Image
Zooming Images



Zooming parts of an Image
See Also
To select an area you want to magnify, click the left mouse button and drag the Zoom tool. When the 
flashing outline surrounds the area you want to zoom, release the mouse button. The Image editor 
zooms the area to the largest zoom percentage that will fit in the window pane.
To zoom the area back out, choose View|Zoom Out or hold down the Shift key and double-click the 
Zoom tool.



See Also
Zooming Images
Zooming the Entire Image



Using Zoom Accelerators
See Also
Three accelerators are listed on the View menu. They are easy to remember and make zooming much 
quicker. 
Instead of choosing the View commands repeatedly until you've adjusted the image to your liking, it's 
much easier to press Ctrl+I or Ctrl+U a few times. If you select the Zoom tool, you can simply double-
click in the image to zoom in and Shift+double-click to zoom out. You can also press Ctrl+A to return the 
image to its actual size.

View CommandAccelerator Mouse Action on Zoom Tool
Zoom In Ctrl+I Double-click
Zoom Out Ctrl+U Shift+double-click
Actual Size Ctrl+A None



See Also
Zooming Images



Moving a Zoomed Image
See Also
If a zoomed image is too large to fit in a window pane, the Image editor displays scroll bars to let you 
move the image around and see different parts of it.
You can also use the Hand tool to grab an image and move it. To turn the current tool into a Hand tool, 
press Ctrl. Then click in the image and drag it in the direction you want it to move. You might have to 
click and drag several times if you want to move a zoomed image more than the total width or length of 
the window pane.
If the image is also displayed unzoomed in another window pane, you can watch the dotted outline 
move as you look at different parts of the zoomed image.



See Also
Zooming Images





Tools Palette (Image Editor)
See Also
When you open an image in the Image editor, the Tools palette is on the left side of the Image Editor 
window. Use the Tools palette to select the Image editor tool you want to work with. 
Choose an icon or tool name for information about how you can use the tool.

Icon Tool Use to
Pick Rectangle Select a rectangular area of the 

image
Lasso Select a free-form area of the 

image
Zoom Zoom all or part of the image

Pencil Draw line with foreground color

Airbrush Place more color in a region as 
time goes on

Eye Dropper Display color under the cursor

Arc Draw an arc line with foreground 
color on to an image

Brush Paint free-form patterns on the 
image

Text Add text to the image

Fill Fill an area of the image with color

Line Paint straight lines

Rectangle Draw a rectangle on the image

Filled Rectangle Draw a rectangle filled with a 
pattern or with color

Rounded 
Rectangle

Draw a rectangle with rounded 
edges

Filled Rounded 
Rectangle

Draw a rectangle with rounded 
edges filled with a pattern or with 
color

Ellipse Draw an ellipse on the image

Filled Ellipse Draw an ellipse filled with a 
pattern or with color

In addition, there's a Hand tool that you can use to move a zoomed image. It's not displayed in the Tools
palette.



See Also
Image Editor



Pick Rectangle Tool 
Tools Palette
You use the Pick Rectangle tool to select a rectangular area of your image for copying, moving, or 
deleting.
To select an area, click the left mouse button and drag the mouse until the flashing outline surrounds the
area you want. Release the mouse button. The cursor turns into the Hand tool. Clicking either mouse 
button outside the outline turns the area selection off.
When you select an area, you can use Edit menu commands to cut, copy, or paste the selected area. 
You can also hold the mouse button down to move the area. 



Lasso Tool 
Tools Palette
You use the Lasso tool to select a free-form area of your image for copying, moving, or deleting. 
To select an area, click the left mouse button and drag the mouse to create a line around the area. 
When the line is a complete circle, release the mouse button. The cursor turns into the Hand tool. 
Clicking either mouse button outside the outline turns the area selection off.
When you select an area, you can use Edit menu commands to cut, copy, or    paste the selected area. 
You can also hold the mouse button down to move the area. 



Zoom Tool 
See Also Tools Palette
You use the Zoom tool to zoom the image. To zoom the entire image, choose Edit|Select All, then the 
Zoom tool.
To zoom an area of the image, click the left mouse button and drag the mouse until the flashing outline 
surrounds the area you want. Release the mouse button. The area is automatically zoomed in to the 
next magnification level.
You can also use the View menu for zooming.



See Also
Zooming a Portion of the Image
Zooming Images
Zooming the Entire Image



Pencil Tool 
Tools Palette
Use the Pencil tool to paint free-form lines and shapes using the current pen style. To sketch with the 
Pencil tool, click a mouse button and drag the pencil across your image. Release the mouse button 
when you finish sketching.

Use the left mouse button to sketch with the current background color 
Use the right mouse button to sketch with the current foreground color 

Before you use the Pen tool, you might want to select the pencil-point style and the foreground and 
background colors.



Airbrush Tool (Image Editor)
Tools Palette
The Airbrush tool paints free-form patterns similar to a real airbrush on your image using the current 
airbrush pattern and shape.
To use the airbrush, you can either click a mouse button once and drag the airbrush, or you can click it 
repeatedly, as if you were repeatedly pressing the nozzle of a spray can. If you drag it slowly, it paints a 
thick pattern. If you drag it quickly, it paints a scattered, thinner pattern.
When you choose the Airbrush tool, you see a cursor that represents the Airbrush tool. The area painted
by the airbrush is always proportionally the same relative to the size of the image frame. 

Use the left mouse button to paint with the current Foreground Color
Use the right mouse button to paint with the current Background Color

Before you use the airbrush, you might want to select the foreground and background colors and specify
the airbrush shape and pattern.



Eye Dropper Tool (Image Editor)
Tools Palette
Use the Eye Dropper tool to copy a color from the current image. This is useful when you have a color in
an image that isn't displayed in your color palette.
To select a color for use with any tool,
1. Select the Eye Dropper from the Tool palette.
2. Click to copy the color as a foreground color, or right-click to copy the color as a background color.
3. Select the tool you want to use with the new color.



Arc Tool (Image Editor)
Tools Palette
Use the Arc tool to create a Bezier arc, curve, or closed loop using the current pen style and color.
To create an arc,
1. Select the Arc tool from the Tool Palette.
2. Click and drag to draw a line of the appropriate length. 
3. Click the line you just created and drag it to create the arc you want. The point you select on the line 

determines the shape of the arc. To create a symmetrical arc, click the center of the line.
4. Without moving the cursor, click again to "set" the arc.
To create a curve,
1. Select the Arc tool from the Tool Palette.
2. Click and drag to draw a line of the appropriate length. 
3. Click the line you just created and drag it to create the arc you want. The point you select on the line 

determines the shape of the arc.
4. Click another part of the line and drag it to create another arc in the line. You can click many points on

the line to create the desired curve.
To create a closed loop,
1. Select the Arc tool from the Tool Palette.
2. Click where you want the closed end of the loop to be. This end is stationary and will not move as you

create the loop.
3. Click where you want the top of the loop to be. This creates a line. This end may move as you create 

the loop.
4. Click the line and drag it to adjust the arc. The arc is mirrored, resulting in a closed loop.
To constrain the lines to 45-degree angles, press Shift as you draw the line. You will only be able to draw
horizontal, vertical or 45-degree lines.

Use left mouse button to draw with the current foreground color.
Use the right mouse button to draw with the current background color.



Brush Tool 
See Also Tools Palette
Use the Brush tool to paint free-form patterns using the current brush pattern and shape. To paint, click 
a mouse button and drag the brush across your image. Release the mouse button when you finish 
painting.
When you choose the Brush tool, you see a cursor that represents the current brush shape and size. 
The area painted by the brush is always proportionally the same relative to the size of the image frame. 

Use the left mouse button to sketch with the current foreground color (left most color sample next 
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you use the brush, you might want to select the brush shape and size, and the foreground and 
background colors.



See Also
Background Color
Foreground Color
Line Width Palette
Pattern Style Palette



Text Tool 
See Also Tools Palette
To add text to your image, choose the Text tool and click where you want the text to begin. A flashing 
cursor appears, and you can begin typing text.
Before you use the Text tool, you might want to specify how and where you want the text displayed:

Use Text|Font to specify the typeface, size, and style of the text.
Use Text|Align Left, Text|Align Center, and Text|Align Right to specify how text is aligned.

Text is always displayed in the current foreground color. Before you type text, you might want to specify 
the foreground color by clicking the left mouse button on the color you want in the Colors palette.



See Also
Adding Text to an Image
Foreground Color



Fill Tool 
See Also Tools Palette
Use the Fill tool to fill an area of your image with the currently selected color. It fills in any area of your 
image that is a single color. 

If you use this tool on an area that's not entirely surrounded by other colors, the color leaks out 
into other parts of the image that are the same color as the original area. 

If you hold down the Shift key when you use the Fill tool, you replace all instances of the color 
you click on, contiguous or not.
To use the Fill tool, point the cursor cross hairs in the portion of the image you want to fill, then click a 
mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you use the Fill tool, you might want to specify the foreground and background colors.



See Also
Background Color
Foreground Color



Line Tool 
See Also Tools Palette
Use the Line tool to paint straight lines. Press the mouse button and drag the Line tool across your 
image. Release the mouse button when you've finished drawing the line.
If you want the lines you paint to be limited to 45-degree increments, hold down Shift as you draw the 
line. With Shift down, you can paint only a horizontal or vertical line or a line on a 45-degree angle.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint a line, you might want to specify the line width and choose the foreground and 
background colors.



See Also
Background Color
Foreground Color
Line Width Palette



Ellipse Tool 
See Also Tools Palette
Use the Ellipse tool to paint an ellipse-shaped empty frame in your image. This tool paints a line around 
the ellipse using the current line width. If you don't want the line displayed, use the Change Width dialog 
box to set one of the line widths to null (0).
To paint an ellipse, place the tool cross hairs where you want the corner of the frame to start. Then click 
a mouse button and drag the tool until the frame outline surrounds the area you want. Release the 
mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint an ellipse, you might want to specify the line width and choose the foreground and 
background colors.



See Also
Background Color
Foreground Color
Line Width Palette



Rectangle Tool 
See Also Tools Palette
Use the Rectangle tool to paint an empty rectangular frame in your image. This tool paints a line around 
the rectangle using the current line width. If you don't want the line displayed, use the Change Width 
dialog box to set one of the line widths to null (0).
To paint a rectangle, place the tool cross hairs where you want the corner of the frame to start. Then 
click a mouse button and drag the tool until the frame outline surrounds the area you want. Release the 
mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint a rectangle, you might want to specify the line width and choose the foreground and 
background colors.



See Also
Background Color
Foreground Color
Line Width Palette



Rounded Rectangle Tool 
See Also Tools Palette
Use the Rounded Rectangle tool to paint an empty frame shaped like a rounded rectangle in your 
image. This tool paints a line around the rounded rectangle using the current line width. If you don't want
the line displayed, use the Change Width dialog box to set one of the line widths to null (0).
To paint a rounded rectangle, place the tool cross hairs where you want the corner of the frame to start. 
Then click a mouse button and drag the tool until the frame outline surrounds the area you want. 
Release the mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint a rounded rectangle, you might want to specify the line width and choose the 
foreground and background colors.



See Also
Background Color
Foreground Color
Line Width Palette



Filled Rectangle Tool 
See Also Tools Palette
Use the Filled Rectangle tool to paint a rectangular filled-in frame in your image. 
This tool paints a line around the filled rectangle using the current line width. If you don't want the line 
displayed, use the Change Width dialog box to set the line width to null (0).
The frame is filled with the current pattern. Change the pattern with the Pattern Style palette. If you want
to use color instead of a pattern, choose the solid black pattern style before you draw the frame. Once 
the frame is drawn, choose the color you want on the Colors palette, then use the Fill tool to fill in the 
frame.
To paint a filled rectangle, place the tool cross hairs where you want the corner of the frame to start. 
Then click a mouse button and drag the tool until the frame outline surrounds the area you want. 
Release the mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint a filled rectangle, you might want to specify the line width, pattern style, and choose the
foreground and background colors.



See Also
Background Color
Colors Palette,
Foreground Color
Line Width Palette



Filled Rounded Rectangle Tool 
See Also Tools Palette
Use the Filled Rounded Rectangle tool to paint a filled-in frame, in the shape of a rounded rectangle, in 
your image.
This tool paints a line around the rectangle using the current line width. If you don't want the line 
displayed, use the Change Width dialog box to set the line width to null (0).
The frame is filled with the current pattern. Change the pattern with the Pattern Style palette. If you want
to use color instead of a pattern, choose the solid black pattern style before you draw the frame. Once 
the frame is drawn, choose the color you want on the Colors palette, then use the Fill tool to fill in the 
frame.
To paint a filled rounded rectangle, place the tool cross hairs where you want the corner of the frame to 
start. Then click a mouse button and drag the tool until the frame outline surrounds the area you want. 
Release the mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint the filled rounded rectangle, you might want to specify the line width, pattern style, and 
choose the foreground and background colors.



See Also
Background Color
Foreground Color
Line Width Palette



Filled Ellipse Tool 
See Also Tools Palette
Use the Filled Ellipse tool to paint an ellipse-shaped filled-in frame in your image.
This tool paints a line around the ellipse using the current line width. If you don't want the line displayed, 
use the Change Width dialog box to set the line width to null (0). 
The frame is filled with the current pattern. Change the pattern with the Pattern Style palette. If you want
to use color instead of a pattern, choose the solid black pattern style before you draw the frame. Once 
the frame is drawn, choose the color you want on the Colors palette, then use the Fill tool to fill in the 
frame.
To paint a filled ellipse, place the tool cross hairs where you want the corner of the frame to start. Then 
click a mouse button and drag the tool until the frame outline surrounds the area you want. Release the 
mouse button.

Use the left mouse button to sketch with the current foreground color (Left most color sample next
to the Colors palette). 

Use the right mouse button to sketch with the current background color (right most color sample 
next to the Colors palette).
Before you paint a filled ellipse, you might want to specify the line width, pattern style, and choose the 
foreground and background colors.



See Also
Background Color
Foreground Color
Line Width Palette



Hand Tool 
See Also Tools Palette
When you display a zoomed image, not all of it always fits in the display. You can use the Hand tool to 
move the image around to see other parts of it. 
Unlike other tools, the Hand tool isn't included in the Tools palette. But you can change any tool (except 
the Text tool) into a hand by holding down Ctrl.
The Hand tool is a grabbing tool because you just click the hand on the image and drag it in the 
direction you want it to move.



See Also
Moving a Zoomed Image



window pane
The edit window you use for creating your image. The Image editor has two window panes, to provide 
two different views of the image.



Pick Rectangle tool
The Image editor tool you use to select a rectangular area of a graphical image for copying, moving, or 
deleting. 



grid
Lines that you can display on your image in the Image editor. Each square of the grid represents a 
single pixel.



Ellipse tool
The Ellipse tool allows you to paint an ellipse-shaped filled-in frame on your image.



Filled Rectangle tool
The Filled Rectangle tool allows you use to paint a rectangular filled-in frame on your image.



Filled Rounded Rectangle tool
The Image editor tool you use to paint a filled-in frame, in the shape of a rounded rectangle, on your 
image.



Brush tool
The Image editor tool you use to paint free-form patterns on your image.



Zoom tool
The Image editor tool you use to zoom an entire image or a part of it.



Eraser tool
The Image editor tool you use to erase an entire image or a part of it.



Fill tool
The Image editor tool you use to fill an area of your image with the currently selected color. 



Line tool
The Image editor tool you use to paint straight lines on your image.



Text tool
The Image editor tool you use to add text to your image.



Ellipse tool
The Image editor tool you use to paint an empty ellipse-shaped frame in your image.



Rectangle tool
The Image editor tool you use to paint an empty rectangular frame in your image.



Rounded Rectangle tool
The Image editor tool you use to paint an empty frame, shaped like a rounded rectangle, in your image.



foreground color
The color in the foreground of your image. It's typically one of the colors you use to create the features 
of your image.



background color
The color that appears to underlie your image. It's also the color that's left behind when you select an 
area and delete or move it. 



Tools palette
The palette you use to select the Image editor tool you want to work with. 



Hand tool
The Image editor tool you use to move your image around. The Hand tool is not on the Tools palette; 
you can change any tool into a hand by holding down the Ctrl key.



Zoom bar
The Image editor bar you use to zoom your image. 

To zoom your image in, click the arrow on the right side of the bar. Each click increases the 
magnification by 100%.

To zoom your image out, click the arrow on the left side of the bar. Each click decreases the 
magnification by 100%.
The magnification value is displayed at the top of the Zoom bar as 1x, 2x, 3x, and so on for one times, 
two times, or three times.



Zoom Buttons
The Zoom buttons are in the bitmap window to the right of where the image size is displayed. To zoom 
your image in, click the plus button. Each click increases the magnification. The maximum magnificiation
is 16x.
To zoom your image out, click the minus button. Each click decreases the magnification.
The magnification value is displayed next to the Zoom buttons as 1x, 4x, 6x, and so on for one times, 
four times, or six times.



Line Width palette
The Image editor palette you use to choose the line width for tools that draw lines. 



Colors palette
The Image editor palette you use to choose a foreground and a background color for your image.



Pattern Style palette
The Image editor palette you use to choose the pattern style for tools that use patterns. 



Window panes
The views of the image you're creating or editing. The window is split vertically and horizontially to show 
the two views side-by-side. 
To display a single image, just move either line that divides the windows to the end of slider portion of 
the window. One or both views can be zoomed.



Lasso tool
The Lasso tool enables you to select a free-form area of your image for copying, moving, or deleting.



File Menu (Image Editor)
See Also
Use the Image editor File menu to create, open, and save new or existing images. The commands on 
the File menu are:
New Creates a new image
Open Opens an existing image
Save Saves the current image using its current name 
Save As Saves the current image using a new name
Close Closes the current image
Exit Closes the open image and exits the Image editor



See Also
Using the Image Editor



File | New (Image Editor) 
File menu
The File|New command allows you select the type of resource file you would like to create: 

resource
C++Builder component resource
bitmap
cursor

icon



Bitmap Properties Dialog Box
Use the Bitmap properties dialog box to:

Identify the image's color format. 

Identify the image's size.

Colors Options
The Colors options sets the number of colors for the image.

Option Effect
2 colors Creates a black and white image.
16 colors Creates a 16-color image (16 color cursors not supported).
256 colors Creates a 256-color image.

Size Edit Boxes
Use the Size edit boxes to identify the size of the image. The maximum size you can work with is limited
by the amount of memory available on your computer.

Edit Box Value
Width Sets the width of the image. Enter the value in pixels.
Height Sets the height of the image. Enter the value in pixels.



Icon Properties Dialog Box
Use the Icon Properties dialog box to:

Choose your image's color format. 

Choose your image's size.

Colors Options
The Colors options determine the number of colors in the image.

Option Effect
2 colors Creates a black-and-white image.
16 colors Creates a 16-color image (16 color cursors not supported).
256 colors Not supported. 

Size Edit Boxes
Use the Size edit boxes to choose the size of the image. The maximum size you can work with is limited
by the amount of memory available on your computer.

Edit Box Value
Width The width of the image. Enter the value in pixels.
Height The height of the image. Enter the value in pixels.



Resource Menu Options (Image Editor)
Select    the File|New menu from the Image Editor, to access and display the Resource menu and its 
associated options from which you can create new resources, edit, rename, and delete existing 
resources. 

Resource Menu Options

New
Select Resource|New option to choose New to create a new resource, or select a resource from the list.

Edit
Choose Resource|edit to modify an existing resource.

Rename
Chose Resource|rename to rename an existing resource.

Delete
Choose Resource|delete to delete an existing resource.



Component Resource Menu Options (Image Editor)
Select    the File|New menu from the Image Editor to select and display the Resource menu options from
which you can create new C++Builder component resources, edit, rename, and delete existing 
component resources. 

Resource (Component) Menu Options

New
Select Resource|New option to create a new resource, or select a component resource from the list.

Edit
Choose Resource|edit to modify an existing component resource.

Rename
Chose Resource|rename to rename an existing component resource.

Delete
Choose Resource|delete to delete an existing component resource.



File | Open Image dialog box (Image Editor)
File menu
Choose File|Open to display the Open Image dialog box.

Open Image Dialog Box
Use the Open Image dialog box to load an existing image into the C++Builder Image editor.

File Name Edit Box
Enter the name of the file you want to load or wildcards to use as filters in the Files list box.

Files List Box
Displays the files in the current directory that match the wildcards in the File Name edit box or the file 
type in the List Files Of Type combo box.

List Files Of Type Combo Box
Choose the type of file you want to open; the default file type is Bitmap file (.BMP). All files in the 
current directory of the selected type appear in the Files list box.

Directories List Box
Select the directory whose contents you want to view. In the current directory, files that match the 
wildcards in the File Name edit box or the file type in the List Files Of Type combo box appear in the 
Files list box.

Drives Combo Box
Select the current drive. The directory structure for the current drive appears in the Directories list 
box.

Network Button
Choose the Network button to set a network connection.



File | Save (Image Editor)
File menu
Choose File|Save to store the active file using its current name. If the file has not been saved previously,
the Save As dialog box is displayed.



File | Save As (Image Editor)
File menu
Choose File|Save As to open the Save Image As dialog box. After you save the image, you can use File|
Save to store changes in the same file.

Save Image As Dialog Box
Use the Save Image As dialog box to change a file name or to save the image in a new location. If the 
file name already exists, C++Builder asks if you want to replace the existing file.

File Name Edit Box
Enter a name for the file you are saving.

Files List Box
Displays the files in the current directory that match the file type in the Save File As Type combo box.

Save in Combo Box
Select the directory where you want to store the file. In the current directory, files that match the file 
type in the Save Files As Type combo box appear in the Files list box.

Save as Type Box
Indentifies the type of files displayed in the Files List Box. The default is the resource type that you 
are presently working with.



File | Close (Image Editor)
File menu
Choose File|Close, which displays a confirmation dialog that allows you to close the opened image.



File | Exit (Image Editor)
File menu
Choose File|Exit to exit Image editor. If you exit the Image editor before saving your changes, you will be
prompted to confirm the changes you made to image you may have open.



Edit Menu (Image Editor)
See Also
The Edit menu provides commands to undo, redo, cut, copy, paste, delete, and select areas of your 
image.
The commands on the Edit menu are:
Undo Undoes your most recent action
Redo Reverses the effect of the most recent Edit|Undo command
Cut Puts the selected area of the image on the Clipboard
Copy Copies the selected area of the image
Paste Inserts the selected area of the image
Select All Selects the entire image



See Also
Using the Image Editor



Edit | Undo (Image Editor)
Edit menu
Edit|Undo "undoes" your most recent action. It inserts any characters you deleted, deletes any 
characters you inserted, replaces any characters you overwrote, and moves the cursor back to its prior 
position.
There is no undo limit; the number of times you can undo is determined by the available memory.



Edit | Redo (Image Editor) 
Edit menu
Edit|Redo reverses the effect of the most recent Undo command. It is effective only immediately after 
you use Edit|Undo or Edit|Redo. 
A series of Redo commands reverses the effects of a series of Undo commands. 



Edit | Cut (Image Editor) 
Edit menu
Edit|Cut puts the selected area of your image on the Windows Clipboard. You can then choose Edit|
Paste to paste the image somewhere else in the same image or in another image.



Edit | Copy (Image Editor) 
Edit menu
Edit|Copy copies the selected area of your image. To paste the copied image somewhere else in the 
same image or in another image, choose Edit|Paste.



Edit | Paste (Image Editor)
Edit menu
Edit|Paste inserts the selected area of your image at the cursor position. This command is active only if 
you select the area with the Edit|Cut or Edit|Copy commands.



Edit | Select All (Image Editor)
See Also Edit menu
Edit|Select All selects the entire image. You can then cut the image and copy, paste, or delete it.



See Also
Edit|Cut
Edit|Copy
Edit|Paste



Text Menu (Image Editor)
See Also
The commands on the Text menu choose how the text in your image is displayed. Here are the Text 
menu commands:
Left Align Aligns text to the left
Center Align Centers text
Right Align Aligns text to the right
Font Chooses the font



See Also
Using the Image Editor



Text | Left Align (Image Editor)
See Also Text menu
The Text|Left Align command aligns text to the left of where you initially clicked before typing the text. 
For example, if you choose Text|Left Align and then use the Text tool to type characters on your image, 
the characters move toward the right side of your image. They're aligned with the original click on the 
left.
Use the Text|Left Align command before you type text or immediately after you finish typing. After you 
click to make another selection, you can't change the alignment of the text you've just typed.



See Also
Adding Text to an Image



Text | Center Align (Image Editor)
See Also Text menu
The Text|Center command centers text. The text is centered in relation to where you initially clicked 
before typing the text. 
For example, if you choose Text|Center and then use the Text tool to type characters on your image, the 
characters move toward the center of your image. They are centered in the image in relation to your 
original click position.
Use the Text|Center command before you type text or immediately after you finish typing. After you click 
to make another selection, you can't change the alignment of the text you've just typed.



See Also
Adding Text to an Image



Text | Right Align (Image Editor)
See Also Text menu
The Text|Right Align command aligns text to the right of where you initially clicked before typing the text. 
For example, if you choose Text|Right Align and then use the Text tool to type characters on your image,
the characters move towards the left side of your image. They're aligned with the original click on the 
right.
Use the Text|Right Align command before you type text or immediately after you finish typing. After you 
click to make another selection, you can't change the alignment of the text you've just typed.



See Also
Adding Text to an Image



Text | Font (Image Editor)
See Also Text menu
The Text|Font command brings up the Font dialog box.
Use this command either before you type text or immediately after you finish typing. After you click to 
make another selection, you can't change the font of the text you've just typed.

Font Dialog Box
Use the Font dialog box to choose the typeface, size, style, and color of the text.

Font Drop-down Box
The Font drop-down box selects the typeface for the text in your image.

Font Style Drop-down Box
The Font Style drop-down box selects the text style.

Size Drop-down Box 
The Size drop-down box selects the font point size.

Effects options
The Effects options choose how the text is displayed.

Option Effect
Strikeout Strikes out text
Underline Underlines text

Color Drop-down Box
The Color drop-down box selects the text color.

Sample Display Box
The Sample display box displays a sample of text in the font and options you've selected.



See Also
Adding Text to an Image



View Menu (Image Editor)
See Also
The Image Editor’s View menu is displayed when you use the Image editor. 
Use this menu to zoom in and out on the displayed image is displayed. View menu commands include:
Zoom In Zooms in the entire image
Zoom Out Zooms out the entire image
Actual Size Returns the image to its actual size



See Also
Using the Image Editor



View | Zoom In (Image Editor)
See Also View menu
The View|Zoom In command zooms in the entire image in the currently selected window. The Image 
editor increases magnification to the next level: 400%, 800%, or 1600%. 
The center of the image is used as a reference when zooming the entire image.



See Also
Using the Zoom Accelerators
Zooming Images



View | Zoom Out (Image Editor)
See Also View menu
The View|Zoom Out command zooms out the entire image in the currently selected window. The Image 
editor decreases magnification to the next level: 800%, 400%, or 100%. 
The center of the image is used as a reference when zooming the entire image.



See Also
Using the Zoom Accelerators
Zooming Images



View | Actual Size (Image Editor)
See Also View menu
The View|Actual Size command returns a zoomed image to its actual size.



See Also
Using the Zoom Accelerators
Zooming Images



Help Menu (Image Editor)
See Also
Use the Image editor Help menu to arrange Help within the Image editor. The commands on the Help 
menu are:
Topics Displays Help topics for the Image editor
About Displays the software version information about the Image editor



See Also
Using the Image Editor



Help Topics (Image Editor)
Help menu
The Help Topics command displays Help Topics dialog box. Use this dialog box to browse the Help table
of contents or use the Index and Find tabs to search for topics.



Help | About (Image Editor)
Help menu
Choose Help|About to see version information for the Image editor.



Icon menu (Image Editor)
See Also
Use the Image editor’s Icon menu to create new icon images, to delete an existing icon, and to create 
new icon images. Available commands on the Icon menu are as follows:
New Replaces the current image with a new blank image
Delete Deletes the current image
Test Tests icons



See Also
Using the Image Editor



Icon | New (Image Editor)
Icon menu
Choose Icon| New from the Icon menu to create a new image of the type you are currently editing.    If 
the current image you are currently working on has not been saved, you will be prompted to save it. 
Changes to any image without saving the image will be lost.



Icon | Delete (Image Editor)
Icon menu
Choose Icon|Delete to delete the image you are currently editing. You are NOT prompted to confirm this 
command.



Icon | Test (Image Editor)
Icon menu
After you select an icon image to test, choose Icon|Test to review and display the icon in the Icon Tester 
dialog box. 

Icon Tester Dialog Box
The Icon Tester dialog box allows you test and view the icon that you are presently editing. It also allows
you to display what the icon will look like using the Color Window combo box located at the bottom.



Resource Menu (Image Editor)
See Also
Use the Image editor Resource menu to set properties for resources, test, and create new resources. 
The commands on the Resource menu are:
New Creates a new resource file where you can store resources you create
Edit Modifies existing resource files
Rename Renames the currently selected resource file
Delete Deletes the currently resource file



See Also
Using the Image Editor



Resource | New (Image Editor)
Resource menu

Choose Resource|New to select new resource (icon, cursor, bitmap) you want to select        the type of
resource you want to create: bitmap, cursor, or icon.



Resource | Edit (Image Editor)
Resource menu
The Resource|Edit command displays the selected resource in an editor window.



Resource | Rename (Resource Editor)
Resource menu
Choose Resource|Rename to rename the selected resource to a new name.

Dialog Box Options
Type the new name for the resoure in the Rename Resource dialog box.



Resource | Delete (Image Editor)
resource menu
Choose resource|Delete to delete the selected option. You are NOT prompted to confirm this selection.



Window Menu (Image Editor)
See Also
Use the Image editor Window menu to arrange windows within the Image editor. The commands on the 
Window menu are:
Cascade Cascades the open windows
Tile Horizontal Tiles the open windows horizontally
Tile Vertical Tiles the open windows vertically
Arrange Icons Arranges the icons for minimized windows
History List Lists the file name of the bitmap images



See Also
Using the Image Editor



Window | Cascade (Image Editor)
Window menu
The Window|Cascade command cascades the open windows so all the titles are displayed, and the 
active window is on top.



Window | Tile Horizontal (Image Editor)
Window menu
Choose Window|Tile Horizontal to see all the open windows tiled horizontally. 



Window | Tile Vertical (Image Editor)
Window menu
Choose Window|Tile Vertical to see all the open windows tiled vertically.



Window | Arrange Icons (Image Editor)
Window menu
Choose Window|Arrange Icons to order the icons of minimized windows in the Image editor.



Window | History List (Image Editor)
Window menu
Choose Window|(File Name) to select that window and make it the active window.




